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The doors
of Japan open-
ed to the rest of the
world at the end of the
Edo period in the mid-
nineteenth century. The
country had been officially
“closed” to foreign intercourse
for the preceding two and a half
centuries, and when a new govern-
ment was launched in 1868, the ensu-
ing trade with several European countries
and the United States brought a tremendous
wave of new, “enlightened culture” to Japan-
’s shores.
Part of that cultural revolution witnessed

the demise of Japanese handmade washi paper

in favor of Western manufactured paper and the

supplanting of the ink brush by the fountain pen.

And now again, some one hundred years later, we
are witnessing the growing use of the word proces-
sor over handwriting of any kind whatsoever. The
flavor of each person’s handwriting which we had for
so long enjoyed has now become watered down to the
hard printed letters of word processors which lack any
personality and look all the same.

This uniformity in the processed and printed word may
achieve a greater efficiency in commumcatlon but the sub-
jective quality of enjoying a person’s handwrmng and feel-
ing the presence of that person’s spirit in it has all but vani-
shed.

It is with this desire to restore what we have lost, not
only in the present age of computers and word processors
but also back in the Meiji period of “enlightened culture”
that we at Enzan-Hoshigumi have developed this new

kind of traditional Japanese word processor (and much
more) called MacCalligraphy. Though we harbor no
illusions that it will ever become accepted in the dai-

ly life of the office, we do hope that those of you

who have discovered the convenience of using
a word processor while atthe same time
wishing for a more personal means of
expression will find MacCalli-
graphy to be just the solu-
tion for you.

FrrX

Hirofumi INOUE, Enzan-Hoshigumi Co., Ltd. January 1987
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1 What is Calligraphy?

I

Calligraphy, in the East, is the art of writing Chinese or Japanese characters. In
Japanese, the word for “writing,” kaku, is the same as for “painting.” The same
techniques used for writing can also be used for traditional Chinese and Japanese
painting, especially those done with black ink. (These techniques can also be
used for painting in color, but they are not yet possible on a black and white
Macintosh screen.)
Using calligraphic techniques for writing in a non-pictorial language, however,
takes on a form that is primarily decorative. These non-pictorial languages include
not only those using the Roman alphabet but also languages such as Russian (in the
cirillic alphabet), Sanskrit (modern Hindi), and even Korean (when written in
Hangul rather than the Chinese characters). What all these languages have in
common is their use of phonetic rather than ideographic (or pictorial) images.
The question of “What is calligraphy?” thus needs to be posed again. If the

West did not always use ideography in their written languages, is it
possible to find any calligraphic interest in the way they were
written by hand?

In Japanese, the word for calligraphy,  shodo ( £38 ) means the “way of
writing [by hand].” The character for “writing” ( 3£ ), the verb bein
pronounced kaku, is similar to the older character for “painting” ),
which has now become the modern Japanese character for “painting”

and nounced kaku when used to refer to a brush
stroke. that the upper part of both these characters are
the same, being a component meaning “brush.” In
English, the other hand, the word “calligraphy” is derived

from a Greek word, kalligraphia, meaning, “beautiful writing.” While it
is clear that, in Japanese, writing by hand and painting belonged to the same
aesthetic consideration, the Greek definition of calligraphy as “beautiful writing”
does not necessarily include any aesthetic value
associated with painting. Yet, anyone who has seen
examples of calligraphy written solely in the
Japanese hira-kana phoneticscript,
such as those elegantly done by
Hon’ami Koetsu back in the
seventeenth century, will
almost certainly
not deny that
these writings
are indeed
“beautiful.”

S5
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R 2 What is MacCalligraphy?

MacCalligraphy is this software package that simulates the basics of
calligraphy on the Macintosh.
When the ink brush is first applied to absorbent paper, washi, the ink flows
from the brush into the paper. And when the pressure on the brush is released,
a “tail” is formed depending upon the release desired by the artist and
according to the type of brush used: It can have a long tail if

released while the brush is still in motion, or just a
wetter spot in one area if released , without any
continued motion. In all cases, ink ’ never ceases
separated

to flow until the brush is completely
from the paper. ’
In MacCalligraphy, the “flow” of ink is controlled by
the mouse button: Ink will begin and continue to flow when
the mouse button is pressed and stop to flow e after some
predeterminable time delay once it is released in order to create
the “tail.” If the mouse button is dragged rela- tively quickly,
the line will be thin. Likewise, if it is dragged slowly, the line
will be thicker. The thicknesses of a line are thus variable and
controlled by their creator.
The tools available on the workscreen will also
in how a line will appear such as in the shade of

allow variations
the black

ink used, the length of the tail attached, the size of the
brush, and the touch of the line. The final ‘ printout
may then be made on the type of washi that is included with
your disks. The many combinations of features possible in MacCalli-
graphy lend themselves easily to a wide variety of artistic effects,
all rendered, of course, in the very simple and ' always beautiful
medium of ink on paper.
‘ .——- g ﬁ: #;' )
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RSESETEX 3 The MacCalligraphy Desktop

& File Edit View Special

When the MacCalli-
graphy application disk is booted up,
the desktop will appear inside a traditional
Japanese tea room with a tokonoma treasure alcove.
Although the System file and other icons operate the
same as they would on the traditional Macintosh desktop,
they have been rearranged to blend into this new environment.
If you donot find the MacCalligraphy application icon on the
floor of the alcove, look for it inside the MacCalligraphy disk icon at
the upper right corner of the screen.
Although the Seals box (on the MacCalligraphy Files disk) and the Calli-
graphic Art box (also on the MacCalligraphy Files disk) have been plac-
ed on the alcove floor by the publishers, they can be returned to their disks
by dragging them into the appropriate disk icons. Boxes may be placed on
the alcove floor, or anywhere else on the screen, by opening a disk icon
and dragging them out of the window.
These treasure boxes can be opened just as a folder can. If another system
is used, these icons will appear as folders again.
Please note that because the beautiful tearoom desktop will not appear if
you use MacCalligraphy with a System and Finder other than those on
the MacCalligraphy disk (unless you copy the MacCalligraphy Startup
Screen icon to the System disk you are using), some of the Mac-
Calligraphy folders, and possibly also the MacCalligraphy appli-
cation icon, will not be found inside the MacCalligraphy disk
window but are instead residing independently as they usu-
ally do near the bottom of the Desktop screen. (Make
sure they are not hiding behind another window!)
— ¢ & e +®
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& File Edit Washi Style Touch Effects
=0 untitled

1. Brush Sizes

2. Inkstone

3. Ink Block

4. Water Dropper

5. Selection Marquis

6. Seal
7. Full Page View
8. Tea Break

Figure 4-1: The MacCalligraphy Work Screen

The tools at the right of the screen and the various menu options are basic to the
operation of MacCalligraphy (Fig. 4-1).

The tools consist of six brush size selections, an inkstone for preparing the ink
to be used, a block of solid ink, a water dipper, a selection rectangle (marquis), a
versatile seal designing tool, a tea ceremony break option, and a “clipboard”
showing the entire page with a page area selection tool.

In addition to the standard editing commands (Undo, Cut, Copy, Paste, and
Clear), the Edit menu includes other commands specially designed for the operation
of MacCalligraphy such as All Clear and Invert.

The Washi menu contains four options which control the speed at which the
“ink” flows from the brush icon, based on the absorbent qualities of four types of
washi paper often used by calligraphers.

The Style menu options control
the length of the “tail,” based on four

historical styles of Japanese calligraphy.

The Touch menu contains five brush
touch options plus a custom touch edit-
ing function.

And finally, the Effects menu offers two 4
special effect options that play upon the general
flow of the line.

Details on all the MacCalligraphy tools and
menus are given below.




Brush Sizes

A total of six brush
sizes are provided on

MacCalligraphy. Click on

the appropriate brush size icon to select
the desired brush size (Fig. 4-1). The
size of the brush icon operated by the
mouse changes accordingly.

The largest brush size is preselected
when MacCalligraphy is booted up.

The Inkstone

The shade of ink in
current use is displayed in
the well of the inkstone (Fig.
4-1). Since no ink has yet been pre-
pared on the inkstone when MacCalli-
graphy is first opened, the ink well is
white, i.e. filled only with clear water.

The inkstone is used to change the
shade of ink in the well, either by
adding more ink from the ink block to
make it darker, or by adding water to
make it lighter.

The Ink Block

In the oriental tradition
of calligraphy, ink normally
comes in a solid form.

In MacCalligraphy, the ink block
icon is preselected since it will have to
be used to prepare the desired shade of
ink on the inkstone (Fig. 4-1). Mac-
Calligraphy offers a total of nine shades
of gray as well as black and white.

To produce the ink shade you wish
to use after booting up the application,
move the mouse icon to the lower por-
tion of the inkstone: The mouse icon at
this point will change to the shape of a
small ink block. (On a real inkstone,
this part of the inkstone is higher than
the ink well and must be wet before ink
can be drawn from the ink block.) Then
hold down the mouse button and move
the icon toward the ink well as though
you were drawing ink from a real ink

MacCalligraphy Tools
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block. With each movement of the icon
to the ink well, you will notice the
shade of ink getting darker and darker
until it turns entirely black.

Shortcuts for ink shade changes
have been built into the keyboard: Press
“1” for a 10% shade of black (the
lightest shade of gray), “2” for a 20%
shade, and on up to “0” for 100%
black. Pressing the “*” key at the upper
left corner of the keyboard will return
the ink well to white.

White will paint over any shade of

black and can also be used as an eraser.
The Water
Dropper

When the water dropper icon (Fig.
4-1) is selected, the shade of ink dis-
played in the well of the inkstone can be
diluted to a lighter shade.

After selecting the water dropper
icon, click on the ink well to dilute the
current shade to the next shade down
toward white.

The number keys at the top of the
keyboard can also be used in this mode
to switch quickly to another shade.
Press “5” for a 50% shade, other
number keys for their corresponding
shades, or “°” at the upper left corner
for white (clear water) only.

The Selection
Marquis g

The Scissors icon (Fig.

4-1) is a selection rectangle (marquis)
used to select an area of the workscreen
for manipulation from the Edit menu.
(Details on the Edit menu options are de-
scribed in Section 4. 2.)

A selected area can also be moved
with the mouse to another portion of the
workscreen if desired by clicking down
on the area and dragging. Or it can be
erased completely by hitting the Back-

space key.
4 .1




The Seal
The seal is an essential é
component in an ink painting

or work of calligraphy. Often, more
than one seal will be found around the
composition, not only the seal of the
artist but also the seals of collectors or
other admirers. Though such seals most
commonly represent personal names
written in Chinese characters, they may
also appear in pictorial form.

With MacCalligraphy, it is possible
to create your own collection of seals
for use on your compositions. New
seal designs may also be saved onto
disk for future use. A substantial col-
lection of seal designs has been includ-
ed on the MacCalligraphy Files disk for
your reference or further editing. For
descriptions of these files, please refer
to Chapter 6.

One click on the Seal icon (Fig. 4-
1) will select it and a second click will
open the Seal Editor grid (Fig. 4-2)
onto the workscreen.

(& Fle EdIt Washl Style Touch Effects

untitled

Figure 4-2: The Seal Editor rid

The first time the Seal icon is
double-clicked, an untitled grid will
appear. At this point, a new seal may be
designed or an existing seal on disk
may be opened.

A new seal can be designed on the
grid by clicking on individual squares
to blacken them. Blackened squares
may be erased by clicking on them a-
gain. An actual view of the seal design

R L LD, L S X O 7O
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can be monitored in the square off the
upper right portion of the grid.

Since traditional seals are circular or
square, a seal frame may be selected
frq(rin the four options to the right of the
grid.
Seals residing on disk may be op-
ened by clicking on the Open button
and selecting the name of the seal to be
opened from the Open menu (Fig. 4-3).
If you had been doing any editing on
the grid before clicking on Open, a
message will first appear asking you
whether you wish to save the changes
before opening the new file.

If you wish to work on a com-
pletely new seal design, click on New
to call up an empty untitled grid. Here
again, a message will appear asking
you if you want to save any changes
you made on the file you were just
working on.

(& Flle Edit Washi Style Touch Effects

1 Hoshigum

1T

Figure 4-3: A Seal Design Opened

from Disk

When a seal is ready to be used,
click on OK and the workscreen will
reappear. Use the mouse to place the
seal wherever desired on the work-
screen. Dragging the mouse with the
button held down will create a line
(albeit without the “tail”) as repeated
impressions of the seal are produced.

To return to the Seal Editor grid,
click once again on the seal icon.

To clear a current display on the
grid, click on the Clear button.

Seal editing changes may be saved

4 .1




[ OO GO OO O C OO ST L

L OA

directly from the grid by clicking on the
Save button and following the instruc-
tions given in the Save menu.

Double clicking on a seal file icon
from the Finder will open MacCalligra-
phy so that the selected seal can be used

immediately after the MacCalligraphy
workscreen appears.
View —
The full page, in A4
letter size, is shown on
this “clipboard.” The por-
tion displayed on the
screen is highlighted by

The frame can be moved by drag-
ging so that another portion of the page
can be displayed on the workscreen.
To completely clear a workscreen,
select All Clear from the Edit menu.
Other portions of the page will remain

Full Page
a rectangular frame. Q
as displayed in the full page view.

T
20,

T
sk )]

The Tea Break

Opening the Tea Bowl
icon has no other function
than to provide you with a
scene in nature as viewed from the
tatami-matted Japanese room where you
have been working with MacCalligra-
phy. This imaginary scene of a Japan-
ese garden as a setting for a Japanese
tea ceremony is intended as a place for
pensive relaxation and enjoyment. The
view outside the room automatically
changes with the season, according to
the calendar operating inside
your Mac.

Clicking the OK button
on the scene returns you
to the MacCalligraphy
workscreen, while click-
ing again on the Tea
Bowl icon returns you
to the garden scene,
with one or two slight
changes each time the
icon is clicked...

MacCalligraphy Tool

e E R P
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The Edit Menu

ndo

Cut %H
Copy ®C
Paste U
Clear

All Clear

Invert &I

vipaque
White
Black

Figure 4-4: Edit Menu Options

The Undo, Cut, Copy, Paste,
and Clear commands work just as they
do in any other program with an Edit
menu containing these options. In
MacCalligraphy, except for the Undo
command, the area to be edited must
first be selected using the Selection
Marquis which can called up onto the
workscreen by clicking on the Scissors
icon (Fig. 4-1). (The Undo command
will cancel any most recent operation
including a most recently drawn line,
etc. It is a very valuable error correc-
tion tool.)

The All Clear command erases
everything on the work screen and al-
lows you to start your work over again.

The Invert command reverses the
colors within an area selected with the
selection marquis: Black areas are
changed to white and the white areas
changed to black. Some very impres-
sive graphic effects can be achieved
with this tool.

The next three commands are set-
tings which govern how an area select-
ed by the Selection Marquis will behave
when itis moved over drawings display-
ed on other parts of the screen. In the

1

MacCalligraphy Menus
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Opaque setting, the entire selected area
is opaque and, whether white or
black, will completely cover over any
other area onto which it is moved. The
White and Black options, however,
give the selected area some transparen-
cy. In the White option, black pixels (a
pixel is one small dot on the screen)
moving over black pixels will turn
white, while in the Black option, black
pixels moving over black pixels will
remain black. Experiment with these
settings and see also what happens
when gray areas are moved over each

other.

The Washi Menu

In traditional Japanese calligraphy,
some types of washi papers absorb ink
more rapidly than others.

To simulate the absorption of ink by
the paper, four options have been install-
ed in the Washi menu (Fig. 4-5) to
control the speed at which the “ink”
flows from the brush icon.

Figure 4-5: Washi Menu Options

The speeds of the Washi menu
options range from Kyoto for the slow-
est speed to Hanshi for the most ab-
sorbent speed. Edo is a relatively slow
speed and Echizen a relatively fast
one. The Washi menu is preset to

4.2
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Hanshi when MacCalligraphy is first
opened.

Icons representing the Washi menu
functions have been provided in the

menu for easy recognition.

The Style Menu

In traditional calligraphy, some
styles of writing have very short “tails”
while others have long “tails” which
lead into the next character much like
our cursive writing does. The Style
menu options (Fig. 4-6) control the
length of the “tail” that is produced
while continuing to draw a line after the
mouse button is released.

Figure 4-6: Style Menu Options

Among the options in this menu,
the Sou style of calligraphy has the
longest “tail” while the Kai style has
the shortest. Ten is relatively long-
tailed and Gyou is relatively short-
tailed. The Kai style is preselected
when MacCalligraphy is first opened.
Icons pictorializing these “tails” are
included in the menu for easy reference.

Some examples of the Kai and
Sou styles in this menu are given in the
Kana Calligraphy files on the MacCalli-
graphy Files disk. Details on these files
and how to use them will be described
in Chapter 6.

’T:l /// MacCalligraphy Menus
////ﬂ%W//WJWIﬂMM}W

The Touch Menu

The “touch” of the brush indicates
the shape of the imprint produced when
the brush first touches the paper.
Various types of calligraphy brushes
are traditionally used to produce dif-
ferent touches and the Japanese names
for those brushes are given next to the
touch icons in this menu. The starting
point of the line will normally retain the
same basic shape of the touch after the
line is drawn.

The Touch menu (Fig. 4-7) offers
several brush touch options including a
Custom Touch option for working with
custom-created touch patterns.

| Touch IS

v, ‘Sui-Hitsu

? Custom Touch

Figure 4-7: Touch Menu Options

Sui-Hitsu literally means “water
brush” and is the most commonly used
type of brush in calligraphy. Its hairs
are stiffended slightly with a glue in
order to produce a firm line. The Sui-
Hitsu touch is preselected when Mac-
Calligraphy is booted up.

Maki-Hitsu, meaning “rolled

4 .2




brush,” is a kind of brush that was in

most common use in Japan up to about
a millenium ago. It derives its name
from the practice of making the handle
by rolling paper around the hairs.

Moku-Hitsu, or “wood brush,”
was used originally for Sanskrit calli-
graphy where the supple wood of the
willow tree was most favored. The
wood fibers were separated with a hard
object such as a stone and then bound
to form the brush. The tip was shaped
as shown in the touch icon to create a
curvilinear effect on paper that re-
sembles the character of Western cal-
ligraphy done with a quill.

Sabaki-Fude literally means “dis-
persed hairs brush.” The hairs of this
type of brush are never drawn together
with glue to form a tip, as in the Sui-
Hitsu, but are allowed to remain fluffy
in order to produce much “wetter”
calligraphic lines.

The Custom Touch option opens
the Custom Touch Editor grid when
selected (Fig. 4-8) and lets you create
or call up your own touch pattern.

The grid will be empty and open as
untitled the first time that Custom
Touch is selected after MacCalligraphy
is booted up (Fig. 4-8).

(& File Edit Washi Style RCTTN Effects

untitied

thure 4-8: Untitled Custom Touch
Editor Grid

When the untitled grid appears on
the workscreen, a completely new
touch pattern can be created, one of the
standard touch patterns can be selected

e i

by clicking on the desired touch icon to
the right of the grid, or a previously
saved touch pattern can be opened by
clicking on the Open button and select-
ing a touch pattern file from the Open
menu (Fig. 4-9). This menu is operated
like any other menu for opening files
into an application.

(&

File Edit Washi Style ROTTEN Effects
T-HANABI
1

Figure 4-9: A Touch Pattern Opened
from Disk

New touch patterns may be created
or existing patterns edited by clicking
on the individual squares of the grid to
add or remove parts of the image.
Progress in this work can be monitored
in the square box off the upper right
side of the grid. This square displays
the actual size of the touch pattern when
it is used in MacCalligraphy with the
largest brush.

To call up a touch pattern stored on
disk, click on the Open button. An
Open menu will appear from which you
can select the name of the pattern you
wish to open onto the grid. Any time
you make changes on a file that was
called up from a disk and you then want
to open another file or a new untitled
grid, a message will first appear asking
you if you wish to save the changes.
This message will also appear if you
did not save changes to the touch
pattern before closing the application.

When finished with any work on
the grid, the touch pattern displayed
may be saved on disk by clicking the
Save button, in which case the System

4.2
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will then ask you to give it a name, if
necessary, on the save menu. Alter-
nately, clicking on the OK button will
return you to the workscreen and acti-
vate the touch from the grid for use as
your new brush.

To call up the grid again, reselect
Custom Touch from the Touch
menu. If the Custom Touch option was
already selected, reselecting Custom
Touch will open the grid showing the
custom touch pattern that was in current
use. If another touch was selected from
the menu after a custom touch option
was used, reselecting Custom Touch
will return the grid showing the most
recently used custom touch pattern.

If a new untitled grid is desired,
press the New button.

Clicking the Clear button will erase
the currently displayed contents of the

Finally, MacCalligraphy can be
opened from the Finder also by double-
clicking on a Touch file saved on disk.
In this event, MacCalligraphy will load
that touch for you directly onto your
brush. (As always, remember that you
must first prepare your ink before
working.)

The Effects Menu

The Effects menu (Fig. 4-10) offers
two options for creating special effects
that influence the way a line is drawn
on the workscreen. These options oper-
ate independently, allowing both of
them to be selected simultaneously.

Figure 4-10: Effects Menu Options
gl o MacCalligraphy Men
e s

us

The Dry option in the Effects menu
toggles between the normal ink mode
and a dry brush mode. The dry brush
mode is activated when selected.

This mode, however, works only
with the grays; to achieve a dry brush
effect with black, select the Mizuho-
Fude option in the Touch menu, or
create a touch pattern on the Custom
Touch Editor grid that will produce the
dry brush effect you want. (See the
section on the Touch menu for details
on how to do this.)

The Underlay option is a gray ink
underlay mode that toggles between
whether a line is drawn over an existing
line on the screen or under it. When
deselected (the normal position) a line
drawn across existing lines will appear
above those lines as usual. When select-
ed, however, that line will be drawn
beneath any existing lines.

The Underlay function works best
between a solid black line and gray or
white lines: The black line(s) must be
drawn first and followed by the gray
line(s). Since gray lines are partially
transparent, a gray line drawn beneath
another gray line will always show
through that line to some degree, creat-
ing a slightly darker area where they
intersect. For this reason, it will not
work also when a black line is to be
drawn beneath a gray line. Real ink on
paper works the same way.




5 A MacCalligraphy Practi

“Eternity”

To
create
“beautiful writing”
or
“beautiful drawing,”
certain basic techniques need to be
practiced and mastered.
When students of
traditional Chinese calligraphy
begin their training,
they usually start with the eight
fundamental strokes found
in the character
for
“Eternity”
(Fig. 5-1).

%

P

Figure 5-1: The Eight Strokes of the Character for “Eternity’

Since
no similar tradition
exists in the West today
to practice writing Roman letters
with an ink brush, we have had to
devise our own quick course for the
benefit of
MacCalligraphy users.

15 5
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I Before moving directly into the writing of individual
letters of the alphabet, however, where each person will
probably develop their own styles of handwriting as they
have done with a quill or pen, let us start out by following
the Eastern tradition of practicing basic strokes first just to
get the “feel” of using MacCalligraphy.

In the letters of the alphabet, there are straight lines,
curved lines, and complete circles. To get accustomed to
” producing these basic shapes, practice writing the patterns
shown in Fig. 5-2. Select the largest brush, the Sui-Hitsu
/ touch from the Touch menu, and Hanshi from the Washi
menu. Remember that lines which are uniform in thickness
are drawn at a uniform mouse speed while those that grow
thinner are drawn by gradually increasing the speed of the
mouse movement. Practicing these patterns will provide
you with a basic skill in using MacCalligraphy which you
can then use to begin experimenting with actual letters and
words in order to develop your own writing styles.
Practice these strokes over and over until you feel suf-

ficiently comfortable with them to venture further.

D____————————-——=——-—= Basic Strokes
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A

Figure 5-2: Some First Practice Strokes

[T}

We recommend that you begin each of your sessions
[ with MacCalligraphy by just practicing strokes such as
these. Explore different settings in the Washi menu, dif-
ferent brush sizes, different touches, and the various ink
shades to familiarize yourself with the tools that are avail-
able to you. Although the program is basically a very
simple one, the creative possibilities it offers are virtually
unlimited.
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Next, let us try some strokes that are commonly used

in traditional Chinese calligraphy such as those found in

the character for “Eternity” introduced earlier (Fig. 5-1).

Even if you do not intend to write actual Chinese cha-

racters yourself, you can still add these techniques to your

repertoire. Some people are nevertheless able to write very

) beautiful Chinese characters without ever knowing the

language simply by familiarizing themselves with what

good Chinese calligraphy looks like and sometimes also by
knowing the meaning of the characters they write.
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EO=——————=Ideographic Strokes ——~———1

-
»

Figure 5-3: Drawing “Tails” from a Point

Iv Figure 5-3 shows the “tails” that can be created from
M one starting point. In this example, the Sui-Hitsu touch is
dC used with the other settings that are preselected when
MacCalligraphy is opened. Press the mouse button and
hold it down until the ink stops flowing. Then release the
button and, at the same time, drag the mouse in one of the
directions shown in the figure. You should be able to
create beautiful tails in no time at all. (In traditional Chin-
ese calligraphy, the brush is never used to draw lines
straight up or out to the upper left: For a right-handed
person, these directions are unnatural.)

ias

Next, draw the lines shown in Fig. 5-4. Press the
mouse button, draw the line, and release the button just
before you make the tail. The white lines shown inside the
lines in Fig. 5-5 indicate the areas of the line that should be
drawn before the mouse button is released for making a
tail. Remember never to draw the line in an unnatural dir-
ection: The third example in Fig. 5-5 should be started at
the left and finish at the bottom. Practice with these tech-
niques until you can reproduce all the lines in Fig. 5-4.
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Figure 5-4: Some Basic Chinese Character Strokes

EO Ideographic Strokes =—

Path followed by the mouse J

Figure 5-5: Dragging Patterns with Mouse Button Held

Down
= Some practical hints
==
‘K@)' 1. Do not concentrate too closely on the brush icon while

you draw. Concentrate instead on producing the end
result without excessive thinking.

2. Do not move the mouse too quickly: Ink will stop
flowing properly if brush movements are too rapid.

3. Develop a sense of rhythm when you draw.

Ideographlc Strokes
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—— Starting point

2925

— Finishing point

Figure 5-6: Two strokes are combined to form part of a
character.

Once some basic strokes have been mastered to a
comfortable degree, the next step is to combine strokes to
form actual characters. This is the area where a developed
sense of rhythm will pay off. Try the combination illustrat-
ed in Fig. 5-6.

Further examples to work with are found in the Kai
Style files in the Kana Calligraphy box on the MacCalli-
graphy Files disk. (The character for “Eternity,” for
another example, is found in the Kai Style 2 file.) Copy
one or more of these examples and paste them onto the
workscreen for further practice. The Copy and Paste
functions work on MacCalligraphy in the same way they
do on other Macintosh programs. The procedures below
describe how to use these and other files:

1. First open the MacCalligraphy application if you have
not done so already.

2. Select Close from the File menu (or click the Close
box) and then select Open.

3. Check to be sure that the MacCalligraphy Files disk is
loaded in the external disk drive. When you see the
names of the files on the Open menu that can now be
opened from that disk, select and open the Kai Style
file you wish to copy from. (If you do not see these
names, check your disk drive selection at the right of
the Open menu.)

4. Use the Selection Marquis (Fig. 4-1) to select the

characters you want to work with.

Complete Ideographs
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5. Choose Copy from the Edit menu and close the file.

6. Choose New from the File menu to open a new,
untitled workscreen.

7. Choose Paste from the Edit menu to bring the copied
images onto the workscreen. You can paste the same
image onto the screen as marny times as you like even
though you might select All Clear from the Edit menu
to erase any work you do not want to keep.

8. If you would like a grid to help guide your composi-
tion, you can paste in a copy of one of the grids stored
in the Calligraphy Grids file (on the MacCalli graphy
2.0 disk) and write your characters in the individual
squares. Pasting characters from the Kai Style files
onto the grid is also possible. School children in China
and Japan use guides such as this one when learning
how to write much as children in the West use ruled
lines to practice their alphabets.

9. The gray Kai Style characters are designed to be traced
directly over the character with black ink. Experiment
with the various brush sizes to achieve the best result
for the particular character you are working on. Paste
in a fresh copy of the character any time you need it.
Remember that you can also select Undo from the Edit
menu to erase the most recently drawn line. (All files
are described in more detail in Chapter 6.)

Creating Customized Practice Files

~Any black character, Roman letter, or other black
image can be changed to gray on MacPaint™ or similar
graphics application. After the image is on the screen of
that application, select the appropriate shade of gray from
the pattern palette and click the Paint Bucket tool anywhere
on the image to change it. Be sure you click on all parts of
the image if they are not touching each other. With this
technique, you can then create your own files of gray
ugages for practicing other creative facets of MacCalligra-
phy.
For users who also own Enzan-Hoshi i’s «

and Earth” series of Japanese Clip Art, ad%lliltir%nal gﬁgﬁ

files can be created from among some of the images
contained in these volumes.

5.3
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& File Edit Washi Style Touch Effects
———

< LHIE Now that we have gained some facility in using Mac-
Calligraphy, it is time to try our hand at painting. Bamboo
is a good subject with which to begin.

& File Edit Washi Style Touch Effects )
= BAMBOO = g =
A s | G|

Figure 5-7: Basic Steps for Painting Bamboo

w'y 1. Draw the large bamboo stalks first using a gray shade
of ink:

A. Press the mouse button and allow the ink to flow.

B. Just before the ink stops, draw a thick line at
uniform speed for the first section of the stalk.

C. Release the mouse button at the end of the section
and hold the mouse in position until the brush icon
stops flickering. Then draw the rest of the sections

T el ,
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2. Draw the joints between the sections using straight
black ink and a smaller brush.

3. Then draw the thinner stalk following the basic
technique given in steps 1 and 2.

4. Next draw the leaves: (A variety of leaves can be

drawn using variations of this technique.)

A. Draw the first part of the leaf without waiting too
long for the ink to flow. Move the brush more
quickly at first and then gradually more slowly to
produce a thicker line toward the center of the leaf.

. Stop drawing at the center of the leaf.

. Release the mouse button and draw the remainder
of the leaf with the “tail” of this stroke.

Q™

You are ready to draw your own bamboo pictures once
you become comfortable with these basic steps. When you
have had your fill of bamboo painting, you can then move
on and try your hand at more complex ink paintings such
as those provided in the files on your MacCalligraphy Files
disk. (See Chapter 6 for descriptions of those ﬁles.x))




XSS 6 The MacCalligraphy Reference Files

The files contained in the treasure boxes that accompany the MacCalligraphy
application are designed as reference and practice aids to learning the Chinese and
Japanese traditions of calligraphy and painting in ink.

On the “MacCalligraphy 2.0” disk is a treasure box called “Calligraphy Grids”
that accompanies the MacCalligraphy application and System box. (The application
icon r;esides on the floor of the treasure alcove, if the MacCalligraphy System is
used.

The second disk, “MacCalligraphy Files,” contains six treasure boxes called
“Kana Calligraphy,” “Roman Calligraphy,” “Touches,” “Calligraphy Back-
grounds,” “InkPaint Skeletons,” “Seals,” and “Calligraphic Art.” (The latter two
file icons also reside on the alcove floor if the MacCalligraphy System is used.)

All these and other files created on MacCalligraphy can be opened on any
program that accepts MacPaint (or other similarly bit-mapped) files. To do so, first
open the application and then open the MacCalligraphy file into it. Otherwise,

double-clicking on a MacCalligraphy file icon will call up the MacCalligraphy
application only.

Calligraphy Grids: “Large Grid”

Use the large grid to practice writing kana syllables or Chinese

characters in the Kai calligraphic style. Use it also to practice writing T T T
letters of the Roman or other alphabets.

AT
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i | Calligraphy Grids: “Small Grid”

EEEEEEENEE The small grid is normally used to practice writing Japanese in

! ! ¢ . : . ‘ : . i i

XN the Sou style of calligraphy. It can also be used to practice writing
smaller letters of the Roman or other alphabets.

Kana Calligraphy: “Kai Style 1”

This file contains 35 samples of the Japanese hira-kana syllabary
in the Kai style of calligraphy. The Kai calligraphic style is the least
cursive of the four options available in the Style menu. Reading
down, starting from the column at the right, they are: a (pronounced
“ah”), 1 (pronounced “ee”), u (pronounced “00”), e (short ‘e’ sound as
in “let”), o (pronounced “oh”), ka, ki, ku, ke, ko, sa, shi, su, se, so,
ta, chi, tsu, te, to, na, ni, nu, ne, no, ha, hi, fu, he, ho, ma, mi, mu,
me, and mo. (All vowels in Japanese are pronounced in the same way
irrespective of the consonant preceding it.)

The characters are given in gray for use in practicing hira-kana
calligraphy. See Section 5.3 for details on their use. For users who
own the “Heaven” or “Earth” scrolls of Enzan-Hoshigumi’s Japanese
Clip Art, this style of calligraphy is similar to that of the Kyoto font.
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Kana Calligraphy: “Kai Style 2." '

The Kai Style 2 file contains the remainder of the Japanese hira- :
kana syllables not included in Kai Style 1, the complete Japanese kata- -
kana syllabary, and the character for “eternity” (Chapter S5). The 3
X
7
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~

’
=

N~

N AN,

remaining hira-kana syllables read: ya, yu, yo, ra, ri, ru, re, ro, wa,
wi, we, wo, and n. (‘n’ is the only syllable in Japanese not followed
by a vowel.)

The kata-kana syllabary follows the same pattern as the hira-kana.
The difference between them is one of usage: The kata-kana are used
primarily for words “borrowed” from foreign languages (except when
Chinese characters are used) and for transcribing proper names into
Japanese that are not originally written in characters. Kata-kana are
also widely used in commercial applications such as advertising and
brand names.

w4 X )N
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J- T op k| Kana Calligraphy: “Kai Style 3”
The meanings of these characters, reading down starting with the

b . :
d }\3- I\ 7]( column at the rlght, are: small, above/top, water, tree/wood,

correct/save/assist, written text, middle, person, road/way/Tao, protect,
b letter (of the alphabet)/character, below/bottom, child, eye, in-

H 3\ stead/generation, three, ten, next, power/energy, and nine. For users
who own Enzan-Hoshigumi’s “Earth” scroll of Japanese Clip Art, this

ﬂg}‘k‘ ‘j‘ Li_ style of calligraphy is similar to that of most of the characters found
in the FUDE file.

Roman Calligraphy: “Roman Font 1”

This file contains the Roman alphabet with both lower- and upper- ABCDE:FGH
case letters and all ten numerals as rendered by a brush. It is one IJ KO{ M N O‘PQ
example of a Roman alphabet font that may be used even to create

your own font files with an application such as FONTastic that is 'EQTU’UU}Q(yZ

specially designed for that purpose.
obedeglgflmap
i3
1234567840

Roman Calligraphy: “Roman Font 2”

The Roman Font 2 file contains all letters of the Roman alphabet
in capitals. The style is a creation that can be reproduced on MacCalli-
graphy alone and represents a demonstration of the program’s versatile
possibilities.
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Roman Calligraphy: “Roman Font 3”

Roman Font 3 contains Roman letters and numerals written in a
calligraphic style closer to that of the Eastern tradition. A whole new
world of font creativity is now possible with MacCalligraphy when
used in combination with another application designed to transfer

file.
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ABGDE
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images such as these into font files that can be loaded into a System M N b‘j\

Calligraphic Art: “BodhidharMac”

This rendering of Bodhidharma manipulating the Macintosh
mouse is an original MacCalligraphy creation of Enzan-Hoshigumi.

SR STU

Calligraphic Art: “Bodhidharma”

This file contains an image of Bodhidharma by an anonymous
“Zen” painter combined with Japanese calligraphy. Bodhidharma is the
“Seventh Patriarch” of Zen Buddhism and is credited with the intro-
duction of Zen (Ch’an) Buddhism to China in the sixth century. His
austere expression is a popular subject among many “Zen” painters.
The calligraphy below this example, roughly translated, reads “Is

friendliness truly a great virtue?” (Naka yoki koto wa, subarashiki
koto kana).

Nec R

Enzan-Hoshigumi co.

Calligraphic Art: “Landscape”

The original of this painting in ink of a Chinese landscape was
done by Shokei, a Japanese Zen painter active mainly at the Kencho-ji
Zen temple in Kamakura from about 1478 to 1506 which was a period
of Japanese history when Zen Buddhist influence on the Japanese arts
was still strong. The landscape by Shokei shown here was “repainted”
on MacCalligraphy. A skeleton version of this painting for practicing

this tradition of art yourself is included in the InkPaint Skeletons file
on the same disk.

The MacCallig

.

raphy Reference Files |
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Calligraphic Art: “Bamboo”

Two renderings of bamboo are found in this file. The first is an
example of a bamboo painting that can be created following the steps
described in Section 5.4. The second is a painting of a bamboo and
pine decoration called Kadomatsu that is commonly placed in the front
of Japanese homes during the New Year’s season. Another example of
a Kadomatsu can be found in the Kankon file on the Japanese Clip Art
‘lf?.anh scroll. Bamboo is a symbol of flexibility, gentility, and long
life.

Calligraphic Art: “Tea Room”

This painting has been included as an example of how MacCalli-
graphy can be used also to create artwork in a Western style.

InkPaint Skeletons: “Landscape Skeleton”

This file is a skeleton version of the Landscape by Shokei found
in the Calligraphic Art treasure box. Copy and Paste all or parts of
this skeleton onto the MacCalligraphy workscreen to practice ink
painting in the Eastern tradition.

le'}:’,,j‘o)":
% 20757 | InkPaint Skeletons: “Toys”

\ - The three images of traditional Japanese objects contained in this

SUAN % file are intended to provide you with an opportunity to practice your
.’Z" ' é{@ hand at painting less complex subjects. Copy and Paste pairs of the
Y images onto the workscreen and use the model to the left of the

skeleton as a guide.




.| Calligraphy Backgrounds:
“Bkgrd 1” and “Bkgrd 2”

Decorative backgrounds are often used to add an air of elegance to
Japanese calligraphy. Hon’ami Koetsu, of the early 17th century, is
— one of the most well-known Japanese calligraphers to use backgrounds

v ' such as the ones included here. They can also be used to decorate
o T messages you write in English on MacCalligraphy.

. : Al Call up a copy of one of these backgrounds and write your
messages directly onto it, or write your message first and then copy it
onto the background. Keep in mind to use copies only of files to
ensure that you do not accidentally damage your originals. The Undo
function in the Edit menu will also help recover actions you do not
want to keep.

Touches

The Touches treasure box contains 16 touch patterns
which are illustrated in the MacCalligraphy Touch Catalog
found at the end of this chapter. Details on how to use these
files are provided in Section 4.2.

&

Seals

The Seals treasure box contains 24 examples of seal
designs that can be created with the Seal Editor described in
Section 4.1. The MacCalligraphy Seal Catalog at the end of
glois chapter illustrates the designs that are included in this

X.




MacCalligraphy Touch Catalog

The sixteen touches contained on the MacCalligraphy Files disk
are illustrated below for your reference. The pattern in the lower left
corner of the box represents the shape produced when that touch is
used with the mouse button held down in only one position. An
example of the line that a particular touch produces is shown above

it. Details on editing or creating your own touch patterns are describ-
ed in Section 4.2.
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The seal designs shown below are contained in the Seals treasure box on the
floor of the MacCalligraphy Desktop alcove (MacCalligraphy Files disk). They
are intended to provide you with samples of seals that can be designed on the
Seal Editor described in Section 4.1. Many of these seals contain basic designs

into which you can insert your own name or initials.
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Appl I
‘ ppie Mac Mac Love
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1id Advertising 2SSO
By Izumi OKANO

OO

Electronic desktop publishing is the current focus of attention in America. Even
the simplest advertisements can be produced using MacCalligraphy and a desktop
publishing program. The advertisement examples on this page illustrate how adver-
tising can attract the attention and interest of an even greater number of people.

Images in advertisements project both objective and subjective impressions:
There is the actual image on the advertising medium itself and there is also the
perceived image in the mind of the viewer. When MacCalligraphy is used especially
for producing the eye-catching components such as the logo or brand name, an

entirely new world of images and possibilities begins to unfold.
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Tokyo Japan
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In this chapter are two short essays
that you may read while taking a tea break
on MacCalligraphy. Click the Tea Break
icon to transport yourself to the Japanese
garden scene and begin to peruse at your
leisure.

1

f// MacCalligraphy Tea Break
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W 8.1 The Manifestation of a Character TS8A

By Mayu KOSAKA

A straight line drawn with MacCalligraphy
is like a cloud that follows behind the path of
an airplane in flight high in the sky. To draw ‘
this kind of line with a machine without
any sound is an experience unsurpassed.

1

To create a program like MacCalli-
graphy which allows one to be able to
write in one’s own handwriting rele-
gates conventional word processing to
the realm of mundanity. It seems odd that
no similar program has appeared before now.

Although the idea of MacCalligraphy was original-
ly designed for use on the Macintosh, its impact on other
technological media such as general word processors and video should
be enormous. The supple flexibility of MacCalligraphy might represent its greatest
contribution.

It does not seem very important what one wants to use MacCalligraphy for,
whether for writing aletter or for painting pictures, as written characters alone do

not express as much as they might until combined with some pictorial element.

MacCalligraphy thus embodies the potential to “write” messages through pictures
as well as with words.

2

Since we have become so accustomed to seeing both
words and pictures in printed or copied form, we have dev-
eloped a habit also of seeing how the complexities of the
message or information are combined within them;
we forget that many of these elements are
actually written or drawn by hand and
that there is a further message that is
imparted in the handwriting itself.
Junzo Ishiko, a cartoon critic, wrote,
“To a [music or other | fan, a portrait
photo with the autograph of the star is
not just another piece of printed matter,
for without the autograph, the printed
photo as a totality lacks life.”
The manifestation of the written char-
acter is good. A picture postcard, because it is
hand written, is also good. However, to
be complete, it must also include a stamp with
its cancellation mark, a description of the picture
on front, and the words, “Post Card,” all occupy-
ing the same small space with the handwritten

Wosmes Way [ 8 ]
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message. Then the handwriting can successfully
give the card its life.

A book or newspaper by Miyatake Gaikotsu
does not appear in the way one might expect.
He uses very common formats such as post-

cards to write his prose more in line with the
way he actually envisions his story. They

| appear as though they had been done
by hand. A combination of word process-
ing functions with MacCalligraphy may well
be able to produce this kind of literary expres-
sion.

Because MacCalligraphy possesses the
rare ability to combine pictures into words
and vice versa, it becomes very difficult to

clearly define whether it is a program for
novelists or for artists!

-
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XXX 8.2 MacCalligraphy Meditation BOETTA

“The tradition
of contemporary B
philosophers has over-
emphasized personal
liberation from mundane
daily occupations. How-
ever, there is still a g
need for those of @

L #

Ere
U

routine

occupations
such as transportation services,
accounting, and inventory control to sense
at least some possibility for a new
from within this normally unattractive
Accounting and bookkeeping is the
system according tothe Ying Yang W princi-
ple of duality. And the computer embodies the
very essence of spiritual science itself.”

These ideas are a summary of what the
author of “990,000 Years of Intellectual
Wisdom” (Hirakawa Publishers) has written,
according to Hiroshi Aramata, who is
generally believed here to represent the re-
incarnation of Kumakusu Minamigata,

a well-known anthropologist.

Place MacCalligraphy at the fore-
front of the business world and the spir-
itual space surrounding the creative
potential of MacCalligraphy will expand
within it. Because all human life is endow-
ed with innate energy to reproduce itself,
it is likewise endowed with the powers to
create. MacCalligraphy is itself a creation which is designed to
encourage such creative endeavors to expand further.

In the spirit generated by the many calligraphers and ink
painters of note, their quiet meditation on their ink and brush
and subsequent acquiescence to their creative powers is tanta-
mount to the discipline of sitting in Zen. The avant-garde scien-
tist of the physics underlying these creative forces, Kunihiko
Hashida, who was also a Zen monk, put forth the theory of
“Science as Spiritual Discipline.” In this same light, we at Enzan-
Hoshigumi aspire to the spirit of “Computer Programming as
Spiritual Discipline,” “Computer Operating as Spiritual Disci-
pline,” and “Desktop Publishing as Spiritual Discipline.” With
mouse in hand and double-clicking on an icon, you too will
enter the fascinating realm of discovery and creativity thanks to the

1 B s \‘.~ S5
g us engaged in B gnereetey i
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By Izumi OKANO
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SIS For Further eading

There are numerous books
available on the subject of Chinese
and Japanese calligraphy that can
be found especially in the major
museum book stores around the
country as well as many books on
Chinese and Japanese ink paint-
ing, frequently dubbed “Zen Paint-
ing” since they were done by Zen
Buddhist priests residing at Zen
temples. Many books on the West-
ern tradition of calligraphy can
also be found. Just a few of these
works are listed here for your
reference.

il

Ecke, Tsung Yu-Ho.

Chinese Calligraphy.

Boston: David R. Godine in
association with the Philadelphia
Museum of Art, 1971.

=

Stribley, Miriam (compiler).
The Calligraphy Source Book.
Philadelphia: Running Press,
1986.

==

Hisamatsu, Shin’ichi.

Zen and the Fine Arts.

Tgkyo: Kodansha International,
1971.

=

Kanazawa, Hiroshi.

Japanese Ink Painting: Early Zen
Masterspieces.

(Japanese Arts Library, vol. 8.)
Tokyo: Kodansha International,

For Further Reading
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Enzan-Hoshigumi Staff
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51?13_7" Hirofumi INOUE . . _ '

g LB Founder and President of Enzan-Hoshigumi Co., Ltd., Mr. I.nouc is the devcloper gnd
writer of MacCalligraphy, a project that has consumed about six months. Mr. Inoue is a
native of Kanagawa Prefecture, just south of Tokyo.

S Izumi OKANO

The writing and editing of all Enzan-Hoshigumi manuals in Japanese is the creative
work of Mr. Okano, a native of Okayama Prefecture. He is also active in planning new
products and editing advertisements and brochures for existing products. If he had any time
left over, Mr. Okano could be found somewhere on the back roads of the country riding
his motor bike.

' V]

Tomoya IKEDA

F Mr. Ikeda is the layout designer of the English MacCalligraphy manual as well as all
£ other Enzan-Hoshigumi manuals. He is also an avid skier and cyclist.

= ﬁ% Takashi YONEDA

E From sunny Miyazaki prefecture, Mr. Yoneda is one of the rare Mac illustrators to be
found in Japan. He is also responsible for the preparation of mechanicals for the Enzan-
Hoshigumi manuals and advertisements.

=] Chie MIMURA

ﬁ‘iﬂiﬂ Ms. Mimura is Enzan-Hoshigumi’s illustrator working on creating and editing most

- of the digitized images for Japanese Clip Art and other products. Ms. Mimura, originally
from Fukushima Prefecture in the north, has lived in a number places of Japan before
settling (temporarily?) in Tokyo.

R Mayu KOSAKA | —

E #E A life-long resident qf Tokyo,. Mr. Kosaka is a free-lancg writer, hlStOI‘lZ.ln, and
resource person for collecting materials that are used for developing Enzan-Hoshigumi’s
products. Whenever he finds time, Mr. Kosaka takes off briefly on a sort of pilgrimmage
to some area of historical interest in Japan.

ml‘“ Yuki YAMAMOTO
55. Originally from Okayama Prefecture, Ms. Yamamoto assists as an illustrator on the

Macintosh as well as with product development.

Jun’ichi MATSUDA

Mr. Matsuda, although a full-time employee of a trading firm in Tokyo, devotes
virtually all of his leisure time in front of the Mac working on graphics and moonlighting
at Enzan-Hoshigumi as a graphics technical advisor. Mr. Matsuda makes his home in
Saitama Prefecture, just north of Tokyo.
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ﬁﬁ*’g Douglas .BRAAT

}‘E?ﬁ A native of New York, Mr. Braat has spent most of his adult life in Japan as a
student of Japanese history and free-lance translator. His affiliation with Enzan-Hoshigumi
came about as a result of many common interests, not the least of which is the Mac-
intosh. Mr. Braat is now based in Still River, Massachusetts, where he now assists Enzan-
Hoshigumi in their marketing efforts internationally.
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